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Writing Extensions

Introduction

BBEdit has a facility for calling code modules which are not part of the application itself. The main reason for this 
facility is so that users and third-party programmers can add specific functionality to BBEdit which goes beyond 
BBEdit’s own charter. For example, one such code module might prepend Usenet attributions to each line in a 
selected range of text. This is a useful function, but it’s not of interest to everyone. 

General Guidelines

BBEdit extensions are built as standalone code resources of type ‘BBXT’. The  capability to build such resources is 
an integral part of THINK C, CodeWarrior. Users of MPW can also build standalone code resources, but with less 
ease.

There may be any number of extensions per file, and extensions can use their own resources. Also, BBXT resources 
can be of any resource ID, since BBEdit manages the extensions in such fashion that resource name or ID conflicts 
don’t happen. Each BBXT resource in a file should have a name as assigned by ResEdit’s “Get Info” command; this 
name will appear under the Extensions menu in BBEdit..

Note: If there are BBXT resources from different files with the same name, users may become confused. Neither 
Bare Bones Software nor BBEdit will arbitrate extension names.

When BBEdit starts up, it takes account of the extensions in the “BBEdit Extensions” folder. The BBEdit Extensions 
folder can reside in the same folder as BBEdit itself. Under System 6, the BBEdit Extensions folder can also reside 
in the system folder on the startup disk; under System 7, the BBEdit Extensions folder can also reside in the 
Extensions folder in the system
folder on the startup disk.

Files containing extensions must be of type ‘BBXT’. The creator can be anything you like, although files with a 
creator of ‘R*ch’ will have a standard icon. (You can, of course, create bundle resources and icons to give the files 
any icons you desire.)

BBEdit extensions should be as friendly as possible. They should take care to release any memory that they allocate 
while running, and they should leave no windows on the screen after they return to BBEdit. In general, BBEdit 
extensions should be considered one-shot text filters: they do their thing, then exit. They should put no menus in the 
menu bar, and should not have an event loop. (They can call ModalDialog(). It’s recommended that you use, or 
layer on top of, the standard filter that BBEdit provides.)

Note: If you wish, you can write an extension that launches a driver; if this is the case, the driver can have a window 
which resides in BBEdit’s own layer, and/or a menu in the menu bar.

You should assume that any callback will move memory. This means that if you keep pointers into any relocatable 
blocks, or pass addresses inside relocatable blocks as function arguments, you should lock the block first. For 
maximum friendliness, move it high with MoveHHi() first. You can combine these actions by using the 
HLockHi() call.

Extensions can put up modal dialogs and alerts, provided they’re taken down again before the extension exits; they 
can also call Standard File or any system services necessary, as long as no attempt is made to bring another 
application to the front.



Programming Interface

Given all of these constraints, what can extensions do?

The answer is: pretty much any transformation on a window’s text that they please.

The interface to BBEdit is kept in a structure known as an ExternalCallbackBlock. This structure begins 
with a 16-bit integer which is the version number of the callback block. If the callback block passed to you is higher 
than one you know about, then there is additional functionality available that you probably don’t know about. 
Conversely, if the version number is less than the one you know about, some functionality that your extension 
requires may not be available.

The current callback interface version is 4. This version of the callback interface is current as of BBEdit and BBEdit 
Lite, version 3.0. We recommend that you check the callback interface version in the ExternalCallbackBlock 
to determine whether the version of BBEdit calling your extension provides the necessary services. 

Following is the C structure definition for an ExternalCallbackBlock. Note that although the members of the 
structure are shown as function pointer declarations, the actual members as declared in ExternalInterface.h 
are ‘opaque’. This was done to facilitate the writing of PowerPC or ‘fat’ extensions, and to provide for easier 
maintenance.

typedef struct {
short version;

/* Version 2 callbacks (BBEdit 2.2 and later) */

pascal Handle (*GetWindowContents)(WindowPtr w);

pascal void (*GetSelection)(long *selStart, long *selEnd, long 
*firstChar);

pascal void (*SetSelection)(long selStart, long selEnd, long 
firstChar);

pascal void (*GetDocInfo)(WindowPtr w, Str255 fName, short *vRefNum, 
long *dirID);

pascal long (*GetModDate)(WindowPtr w);

pascal Handle (*Copy)(void);

pascal Handle (*Paste)(Handle pasteText);

/* Text-Editing stuff */
pascal long (*GetLastLine)(void);

pascal long (*GetLineNumber)(long selection);

pascal long (*GetLineStart)(long selection);

pascal long (*GetLineEnd)(long selection);

pascal long (*GetLinePos)(long line);

pascal void (*Insert)(char *text, long len);

pascal void (*Delete)(void);

/* Getting and Setting window text */



pascal void (*SetWindowContents)(WindowPtr w, Handle h);

pascal void (*ContentsChanged)(WindowPtr w);

/* Reading file text */
pascal Handle (*GetFileText)(short vRefNum, long dirID, Str255 fName, 

Boolean *canDispose);

/* Direct user-interface calls */
pascal Boolean (*GetFolder)(Str255 prompt, short *vRefNum, long 

*dirID);

pascal Boolean (*OpenSeveral)(Boolean sort, short *file_count, 
StandardFileReply ***files);

pascal DialogPtr (*CenterDialog)(short dialogID);

pascal Boolean (*StandardFilter)(DialogPtr d, EventRecord 
*event, short *item);

pascal void (*FrameDialogItem)(DialogPtr d, short item);

pascal WindowPtr (*NewDocument)(void);

pascal WindowPtr (*OpenDocument)(void);

/* Utility Routines */
pascal Handle (*Allocate)(long size, Boolean clear);

pascal long (*FindPattern)(char *text, long text_len, long 
text_offset, char *pat, long pat_len, Boolean case_sensitive);

pascal void (*ReportOSError)(short code);

/* Preference routines */
pascal void (*GetPreference)(ResType prefType, short req_len, void 

*buffer, short *act_len);

pascal void (*SetPreference)(ResType prefType, short req_len, void 
*buffer, short *act_len);

/* Progress routines */
pascal void (*StartProgress)(Str255 str, long total, Boolean 

cancel_allowed);
pascal Boolean (*DoProgress)(long done);
pascal void (*DoneProgress)(void);

/* Version 3 callbacks (BBEdit 2.5 and later) */

pascal Boolean (*GetProjectList)(FSSpec *spec, short *kind, short *count, 
ProjectEntry ***entries);

pascal Boolean (*ProjectTextList)(FSSpec *spec, Handle *text);

/* Version 4 callbacks (BBEdit 3.0 and later) */
pascal Boolean (*PresetUndoProc)(void);
pascal void (*SetUndoProc)(void);

pascal Boolean (*OpenFileProc)(FSSpec *spec, WindowPtr *w);
} ExternalCallbackBlock;

Each field of the callback block is a pointer to a routine. Each routine is called with the Pascal calling convention; in 
the following descriptions the pascal keyword is omitted for clarity.

Handle (*GetWindowContents)(WindowPtr w);



returns a handle to the text in the window pointed to by w. This routine should only be called on windows 
which have a window kind of userKind.

void (*GetSelection)(long *selStart, long *selEnd, long *firstChar);

Sets the 32-bit integers pointed to by the arguments to the character offsets of the start of the selection, the 
end of the selection, and the first visible character in the active editing window.

void (*SetSelection)(long selStart, long selEnd, long firstChar);

Sets the selection range and first visible character in the active editing window to the values passed. If 
firstChar is -1, the selection range will be centered in the window.

void (*GetDocInfo)(WindowPtr w, Str255 *fName, short *vRefNum, short 
*dirID);

Returns information about the window pointed to by w. If the window corresponds to a document that 
doesn’t exist on disk, then fName will be an empty string, and vRefNum and dirID will be set to zero. 
This routine should only be called on windows with a window kind of userKind.

long (*GetModDate)(WindowPtr w);

Returns the modification date (in Macintosh time) of the document whose window is pointed to by w. If the 
document is saved on disk, then the last-modified time of the file is returned; otherwise the time of last edit 
is returned. This routine should only be called on windows with a window kind of userKind.

Handle (*Copy)(void);

Returns a handle to a copy of the text enclosed by the current selection in the active document. The caller 
is responsible for disposing of this handle when finished with it.

Handle (*Paste)(Handle pasteText);

Pastes the text in the handle pointed to by pasteText into the current selection range of the active 
document. The caller is responsible for disposing of this handle when finished with it.

long (*GetLastLine)(void);

Returns the number of lines in the active editing document.

long (*GetLineNumber)(long selection);

Returns the line number of the character offset indicated by selection.

long (*GetLineStart)(long selection);

Returns the character offset of the beginning of the line that selection is on.

long (*GetLineEnd)(long selection);



Returns the character offset of the end of the line that selection is on.

long (*GetLinePos)(long line);

Returns the character offset of the beginning of line.

void (*Insert)(char *text, long len);

Inserts the len characters pointed to by text in the current selection range of the active editing document.

void (*Delete)(void);

Deletes the characters enclosed by the selection range in the active editing document.

void (*SetWindowContents)(WindowPtr w, Handle h);

Replaces the contents of the document designated by w with the contents of the handle h. 

Note: after calling SetWindowContents, the handle belongs to the window, and must not be disposed. 
Also, if you modify the contents or size of the handle pointed to by h after using it in a 
SetWindowContents() call, be sure to call  ContentsChanged() for w.

void (*ContentsChanged)(WindowPtr w);

This routine should be called if you directly modify the text returned from a GetWindowContents() 
call.

Handle (*GetFileText)(short vRefNum, long dirID, Str255 fName, Boolean 
*canDispose);

Loads the contents of the designated file’s data fork into memory, and returns a handle to those contents. If 
there was an error (insufficient memory, file system error, etc), GetFileText() will return NIL.

The canDispose argument will be set to TRUE if the text was loaded from disk, FALSE if the text 
belongs to an open window. In the event that canDispose is TRUE, then you should dispose of the text 
(or use it in a SetWindowContents() call). If canDispose is FALSE, then you must not dispose 
the handle, or else you’ll crash BBEdit. Also, you must not modify the contents of the handle if 
canDispose is FALSE.

Boolean (*GetFolder)(Str255 prompt, short *vRefNum, long *dirID);

Displays a Standard File dialog box for choosing a folder. Returns TRUE if a folder was selected, FALSE if 
the user clicked the  Cancel button. The vRefNum and dirID of the chosen folder are returned in 
vRefNum, and dirID, respectively.

Boolean (*OpenSeveral)(Boolean sort, short *file_count, StandardFileReply 
***files);



Displays a Standard File box for choosing multiple files at once. Returns TRUE if the user chose any files, 
FALSE if the Cancel button was clicked. If sort is TRUE, then the files returned will be sorted in 
alphabetical order; otherwise, the files will be returned in the order the user added them to the list.

The number of files chosen will be returned in file_count, and a handle to a list of 
StandardFileReply records (system 7  style) will be returned in files.

DialogPtr (*CenterDialog)(short dialogID);

Loads the dialog box indicated by dialogID and centers it on the screen. The dialog ID should 
correspond to a dialog which is  available in the extension’s resource file, and nowhere else. (The resource 
map chain is configured such that none of your dialog IDs can conflict with BBEdit’s.)



Boolean (*StandardFilter)(DialogPtr d, EventRecord *event, short *item);

This standard filter performs some useful standard behavior, such as outlining the default button with a 
thick border, and handling activates and deactivates for BBEdit’s own windows. It is strongly 
recommended that you pass this pointer as the filterProc argument when calling ModalDialog() 
or Alert(). If you’re writing custom dialog filters in your extension, you should call this routine directly 
after doing your own preprocessing.

void (*FrameDialogItem(DialogPtr d, short item);

This routine will draw a rectangle around the dialog item specified. If the item is a line, a line will be drawn 
using true gray.

WindowPtr (*NewDocument)(void);

Opens a new untitled document, and returns a pointer to its window. This document becomes the current 
document. Will return NIL if for some reason the window couldn’t be opened.

WindowPtr (*OpenDocument)(void);

Puts up BBEdit’s standard Open dialog for choosing a file. If the user confirms the dialog and the document 
is successfully opened, returns a pointer to its window. Will return NIL if the user  cancels the dialog or if 
an error occurred while opening. (If some system error occurs, BBEdit will pose the alert box.)

Handle (*Allocate)(long size, Boolean clear);

Allocates and returns a handle of size bytes. If the clear argument is TRUE, the handle will be zeroed. 
The handle returned will be a real handle, but may reside in MultiFinder temp memory. As with any handle, 
you should avoid locking handles returned by Allocate() for any length of time, and you should 
dispose of the handle before returning.

long (*FindPattern)(char *text, long text_len, long text_offset, char 
*pat, long pat_len, Boolean case_sensitive);

Searches the text buffer pointed to by text for the string of characters pointed to by pat. text_len is 
the amount of text to search. text_offset is the position relative to the start of the text to start 
searching. pat_len is the length of the string to match. If case_sensitive is TRUE, then the case of 
potential matches will be checked.

FindPattern() will return the offset relative to the start of the text that the string was found. If the 
string was not found, FindPattern() will return -1.

void (*ReportOSError)(short code);

Displays an alert box with the proper OS error message corresponding to the OS result code given in code. 
This is handy for reporting filesystem errors, out of memory, and things of that sort.



void (*GetPreference)(ResType prefType, short req_len, void *buffer, 
short *act_len);

void (*SetPreference)(ResType prefType, short req_len, void *buffer, 
short *act_len);

The GetPreference and SetPreference calls are for extensions to use to save and retrieve 
extension-specific information across runs. The settings are stored in the BBEdit Prefs file as resources.

GetPreference will retrieve the preference data stored in the resource of prefType, resource ID 128, and 
copy the contents of that resource into the data pointed to by buffer. In all cases, req_len represents 
the maximum number of bytes which will be copied. (Warning: the amount of data allocated in buffer, be 
it a static structure or a handle, must be equal to or greater than req_len, or else havoc will occur.) The 
word pointed to by act_len will be filled in with the actual number of bytes copied; this is always less 
than or equal to req_len. If act_len is negative, the value in act_len is an OS error code (usually 
resNotFound if you’re calling GetPreference with a virgin Preferences file).

SetPreference is the complement of GetPreference; it writes out the data in buffer to a 
resource of type resType, id 128. req_len and act_len behave as for GetPreference.



void (*StartProgress)(Str255 str, long total, Boolean cancel_allowed);
Boolean (*DoProgress)(long done);
void (*DoneProgress)(void);

StartProgress, DoProgress, and DoneProgress are used in concert to provide simple progress 
dialog functionality for your extension.

You should call StartProgress at the beginning of a long operation. str will be displayed in the 
progress dialog. total is an indicator of the overall length of the process. For example, you could pass the 
number of lines you’re processing, or the number of bytes you’re processing, or some other scalar 
indication of the length of the process. If cancel_allowed is TRUE, then DoProgress will return 
TRUE if the user pressed Command-Period (and thus wants to cancel the process).

Note: If you pass -1 as the “total” parameter, BBEdit will use the “candy-stripe” progress bar to 
indicate a process of unknown length. However, this capability is supported only in version 4 and later of 
the callback interface.

During your processing, you should call DoProgress as often as you wish. The argument you pass to 
DoProgress reflects the amount, in terms of the total argument to StartProgress, that has been 
completed. If you passed TRUE as the cancel_allowed argument to StartProgress, and the user 
has pressed Command-Period, DoProgress will return TRUE. If this happens, you should abort your 
processing. If you passed FALSE as the cancel_allowed argument to StartProgress, you can 
ignore the result of DoProgress, but you should still call it as frequently as you can.

When your process is complete, you should call DoneProgress. This callback will remove the progress 
dialog from the screen. You should always match a StartProgress call with a DoneProgress call, 
and you should never call DoneProgress without having called StartProgress.

Note: BBEdit uses a heuristic to determine whether it’s worthwhile to display the progress dialog. For this 
reason, the progress dialog may not be displayed during shorter processes.

Boolean (*GetProjectList)(FSSpec *spec, short *kind, short *count, 
ProjectEntry ***entries);

GetProjectList() takes as input the address of an FSSpec; the FSSpec refers to a THINK C/Symantec C++, 
THINK Pascal, or CodeWarrior project. If GetProjectList() returns TRUE, the short pointed to by “kind” 
will be filled in with a value indicating the type of project document:

enum
{

kTHINKCProject,
kTHINKPascalProject,
kCodeWarriorProject

};

The short pointed to by “count” will be filled in with the number of items in the project, and the handle pointed 
to by “entries” will be filled in with a handle to a list of project-file entries. Each entry describes the location and 
type of a file referred to by the project:



typedef struct
{

FSSpec spec; // designates file on disk
long key; // used internally

char tree; // 0 for absolute, 1 for project, 2 for system
Boolean found; // FALSE if file couldn't be located; 
if so, all other info is moot

OSType type; // file type of found file
OSType crtr; // signature of found file's creator

short spare0; // used internally
long spare1;

} ProjectEntry;

The “tree” member of a ProjectEntry is one of the following:

enum
{

kNeitherTree, // outside of either system or project tree
kProjectTree, // in a subdirectory of the project document
kSystemTree // in a subdirectory of the compiler

};

Boolean (*ProjectTextList)(FSSpec *spec, Handle *text);

ProjectTextList() will generate a textual listing of the project document’s contents. If it returns TRUE, the 
handle pointed to by “text” will be filled in with a handle the text itself. As with GetProjectList(), the 
“spec” argument is the address of an FSSpec referring to the project document on disk.

Boolean (*PresetUndo)(void);
void (*SetUndo)(void);

PresetUndo() and SetUndo() are used in tandem, so that the user can reverse the effect of your extension by 
choosing the “Undo” command from BBEdit’s Edit menu. Your extension should call PresetUndo before starting 
an undoable action, and SetUndo after completing it. Before calling PresetUndo, set the selection range to 
encompass the text you’ll be modifying. If you plan to change, delete, or replace all of the text in the window, then 
set the selection range to {0, 0x7FFFFFFF} before calling PresetUndo.

Note: In order for your extension to be undoable, the “Can be Undone” bit in the ‘BBXF’ resource needs to be set. 
See “Extension Control Flags”, below.

Boolean (*OpenFile)(FSSpec *spec, WindowPtr *w);

Use OpenFile() to open a specific file from disk. BBEdit will return TRUE if the file referred to by “spec” was 
successfully opened, and the WindowPtr pointed to by “w” will contain a pointer to the newly opened document’s 
window.

For examples of how to use the various callbacks, look at the sources to the standard extensions in the “Extension 
Sources” folder.



Extension Control Flags

BBEdit provides a mechansim by which the extension writer can control the behavior of the extension, and inform 
BBEdit of the extension’s capabilities. If a four-byte resource of type ‘BBXT’ is in the same resource file as the 
extension, and has the same resource ID as the extension, then BBEdit will treat the contents of the ‘BBXT’ resource 
as flags to control the behavior of BBEdit with respect to the extension.

The “BBXT Resource Template” file contains a resource template suitable for use by ResEdit or Resorcerer1*. You 
can copy and paste the ‘TMPL’ resource into your resource editor, its preference file, or merely have the file 
containing the template open while you’re editing ‘BBXF’ resources.

The names and meanings of the flags are as given in the following table. Note that the bits are grouped together for 
easier understanding; the groupings are not necessarily representative of the bits’ ordering in the ‘BBXF’ resource:

Bit Name Meaning
Undo-Savvy If set, then your extension performs an undoable action. Use this bit in 

conjunction with the “‘Can’t Undo’ Alert” and “Can be Undone” bits (see 
below).

Can’t Undo Alert If the “Undo-Savvy” bit is set, and the “Can Be Undone” bit is not set, then 
BBEdit will issue the alert: “(extension name) cannot be undone. Do you wish 
to continue?” before running your extension. If your extension does not modify 
the front window, then set this bit to zero, the “Undo-Savvy” bit to one, and 
BBEdit will not present the alert before running your extension. (See the 
“Project Statistics” and “Concatenate” extensions for examples.

Can Be Undone If set, then BBEdit expects your extension to use the PresetUndo and SetUndo 
callbacks, and will change the “Undo” item on the Edit menu accordingly after 
your extension has run.

Requires Non-Empty Window If set, BBEdit will disable the item on the Extensions menu corresponding to 
this extension, if the front editing window has no text in it.

Requires Changeable Window If set, BBEdit will disable the item on the Extensions menu corresponding to 
this extension, if the front window is read-only (or a browser window).

Requires Edit Window If set, BBEdit will disable the item on the Extensions menu corresponding to 
this extension, if the front window is not an editing window.

Requires Selection If set, BBEdit will disable the item on the Extensions menu corresponding to 
this extension, if the selection range in the front window is empty.

Requires PowerPC If set, then the extension will only run on a Power Macintosh. (Do not set this 
bit if you are writing a ‘fat’ extension. See “Writing PowerPC Extensions”, 
below, for more details.) BBEdit will disable the item on the Extensions menu 
corresponding to this extension, if this bit is set and BBEdit is not running on a 
Power Macintosh (or if the “BBEdit Power” plug-in is missing).

Unused & Reserved (startup) Reserved for future expansion; should be set to zero.
Use Option key for Defaults Reserved for future expansion;  should be set to zero.
Supports New Interface reserved for future expansion; should be set to zero, or your extension will 

crash.

1* Resorcerer is a product and trademark of Mathemæsthetics, Inc. Applelink: RESORCERER. Internet: 
resorcerer@applelink.apple.com.



Writing PowerPC Extensions

BBEdit 3.0 is accelerated for Power Macintosh, and the extension developer’s kit provides for the creation of 
extensions containing native PowerPC code, for increased performance.

Extensions containing PowerPC code may be ‘accelerated’ code resources, or ‘fat’ code resources. An ‘accelerated’ 
code resource is one that consists solely of PowerPC code, and can only run on Power Macintosh machines. A ‘fat’ 
code resource contains both 68K and PowerPC code, as well as a code header which makes the determination at 
runtime of which piece of code should run.

This document does not explain how to construct fat or accelerated code resources. The currently available PowerPC 
development systems, including Metrowerks’ “CodeWarrior” and Apple’s “Macintosh on RISC SDK” include 
information and examples; in addition, Inside Macintosh: PowerPC System Software, published by Addison-Wesley, 
gives important information in the construction of accelerated and fat code resources.

The “Educate Quotes” example, supplied in this developer’s kit, provides a working example of how to write a ‘fat’ 
BBEdit extension. The scripts and Rez description files will prove useful for creating your own fat extensions, as 
well.

Some important things of which you should be aware:

• When creating an ‘accelerated’ code resource (one that requires a PowerPC for execution), be sure to 
set the “Requires PowerPC” bit in the ‘BBXT’. When you do so, BBEdit will disable the menu item 
corresponding to that extension. If you do not set this bit, users on 68K Macs may attempt to use your 
extension, with unpleasant results.

• When creating a ‘fat’ code resource, we recommend that you use the ‘sdes’ fat resource header (see the 
Educate Quotes example). This will provide transparent compatibility with both 68K and PowerPC 
Macintosh models.

BBEdit 3.0 provides support for PowerPC extensions by setting up the callback routine addresses to be the addresses 
of Mixed-Mode Manager routine descriptors. This has two practical consequences:

• If you’ve written extensions for BBEdit before, you’ll find that you need to change your source code in 
order to work with the new ExternalInterface.h. The changes are very similar to the changes 
required for older programs to compile with the new “universal” Mac headers: instead of directly 
calling a function pointer, use a macro to call the function pointer with the proper arguments.

• BBEdit Lite does not support the use of any extensions containing PowerPC code. If you want to write 
native PowerPC extensions to use with BBEdit Lite, you’ll need to create routine descriptors yourself, 
using the constants in ExternalInterface.h. Note that the routine descriptors should be created with the 
“kM68kISA” architecture, since they’re the addresses of emulated 68K routines.



Demo Extensions

In addition to 827 and Prefix Lines, the following demo extensions are supplied:

Concatenate Files

Concatenate Files is a simple extension which demonstrates more of BBEdit’s extension facilities. This extension 
poses an “Open Several…” dialog in which you can specify a number of text files. The files you designate will be 
concatenated and the text of all of them will be placed in a new untitled window (provided that there is enough 
memory).

Educate Quotes

Educate Quotes is a simple extension which converts straight quotes in your document into “smart” quotes, just as if 
you had manually gone through the document and re-typed all of the quotation marks with Smart Quotes turned on 
for the document. Educate Quotes is also used as an example of how to write a “fat” extension, that is, one that runs 
native on both PowerPC and 680x0 Macs. See the section “Writing PowerPC Extensions” for more information

Hello World

Hello World is a trivial extension that creates a new untitled document window with the text “Hello World” in  it. It 
is purely a demo, with no useful function whatsoever.

Cut Lines Containing

This extension will search through the current document for lines which contain the search string that you enter in 
the dialog box. Each line found will be placed in the Clipboard and deleted from the document.


